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IBM(R) WebSphere(R) Host Publisher
Version 4.0.1 

Readme 

This document contains information supplementary to the online help and the publications. It describes 
such things as newly-added function, hints, tips, restrictions, and corrections. 

This document is updated from time to time. To view the most current version, refer to the Host 
Publisher Library under "Product Documentation." 

Note: To use the HTML links in this document, you must view it using a standard Web browser (not an 
HTML reader) and you must be connected to the Internet. 

Thank you for choosing Host Publisher! 
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Supported versions of WebSphere Application Server

Host Publisher 4.0.1 for AIX, Solaris, Windows NT, Windows 2000, and iSeries requires 
WebSphere Application Server ("WebSphere") Version 5 and requires that one of the following 
be installed on the server: 

❍     WebSphere Application Server base 5.0.1 (AIX, Solaris, Windows, iSeries) 
❍     WebSphere Application Server Enterprise 5.0.1 (AIX, Solaris, Windows) 
❍     WebSphere Application Server - Express for iSeries 5.0 (iSeries) 

Host Publisher also supports running in a federated environment. 

Before you install Host Publisher, you must upgrade WebSphere Application Server to Version 5. 

We recommend that you check the Host Publisher Support Web site for an up-to-date list of 
WebSphere Application Server maintenance that should be applied before you install Host 
Publisher. 

Problem installing on AIX or Solaris systems running X server 
in 16 bit-color

When installing Host Publisher on a AIX or Solaris systems, you might see the following error: 

Exception occurred during event dispatching
java.lang.InternalError:  Unsupported 16-bit depth

A blank panel appears, and you cannot continue the installation. 

This problem occurs because Java does not support 16-bit graphics. To bypass this problem and 
install Host Publisher, configure the X server to a different depth (such as 8-bit, 24-bit, or 32-bit), 
before starting the Host Publisher Server installation. 

Double-byte character set (DBCS) limitations when installing on 
AIX

For Japanese, Korean, Simplified Chinese, and Traditional Chinese versions of Host Publisher 
only: 

When you install Host Publisher Server on AIX, the installation panels might lose input focus 
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because the system is creating an "AIX Input Method" window. If this happens, simply click the 
title bar on the installation panel and continue the installation process. 

Additionally, the Product Registration panel for some countries might not accept double-byte 
character set (DBCS) input. Use single-byte characters on the Product Registration panel. 

Installation and Configuration commands on OS/400 not 
supported for Turkish and Arabic Languages

If you are using OS/400 V5R1 or earlier, Host Publisher Server's installation and configuration 
commands cannot be performed in the Turkish or Arabic languages. This is because the QShell 
environment of OS/400 V5R1 and earlier does not support these locales. 

Note that, after you have installed and configured Host Publisher Server using any language 
supported by Qshell, other functions of the Host Publisher Server support the Turkish and Arabic 
languages. (Arabic is only supported if you purchased Host Publisher with the iSeries Client 
Access Family.) 

If you are using OS/400 V5R2, this is no longer a problem. Installation and configuration 
commands for Turkish and Arabic are supported. 

ikernel.exe exception

If, during installation on either the Server or the Studio, you encounter an ikernel.exe exception, 
stop all processes and restart the computer. After the machine is restarted, initiate the installation. 

Third-party license terms and conditions, notices, and 
information

This product contains third party components: xalan.jar and xerces.jar. The relevant terms and 
conditions, notices and other information are provided in the "LICENSE.TXT" file on the root 
directory of the first installation CD-ROM for this product. Please note that any non-English 
version of the information in this file is unofficial and is provided to you for your convenience 
only. The English version of the file is the official version. 

Coexistence with Host Access Transformation Server (HATS)

If you are installing Host Publisher on a WebSphere Application Server where you also install 
HATS, a NoSuchMethodError message is displayed when running HATS applications. The error 
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occurs because the HATS application uses the habeansnlv.jar file installed in the WebSphere 
\lib\ext directory by Host Publisher, rather than the habeansnlv.jar file defined by the HATS 
application. By default, WebSphere searches for .jar files in \lib\ext first. 

You can use WebSphere administration to set the class loader policy for the HATS application so 
that classes defined in the HATS application are used before classes defined outside the 
application. To set the class loader policy in WebSphere administration, follow these steps: 

❍     In the left pane, click the plus sign (+) to expand Applications. 
❍     Click the Enterprise Applications link. 
❍     In the right pane, click the link for your HATS application. 
❍     On the Configuration tab, locate the Classloader Mode. Change the mode to 

PARENT_LAST. 
❍     Click Apply. 
❍     A message tells you to save the changes to your configuration. Save the changes. 
❍     Return to the Enterprise Applications. 
❍     Stop the application. 
❍     Restart the application. 

If you continue to receive the NoSuchMethodError message, stop and restart the application 
server where the HATS application is installed. 

Configuration and setup considerations

Sensitive information in trace files

For service reasons, Host Publisher trace files contain all user data being processed, including 
potentially sensitive data such as user passwords. 

On UNIX platforms, the default directory containing these trace files is secured against anyone 
viewing its contents except for the owner of the directory (user nobody) and the root user. The 
default directory paths are as follows: 

AIX 
/usr/HostPublisher/log 

Solaris 
/opt/HostPublisher/log 

If you change the location for trace and log files, you should similarly secure the new location. 

On OS/400, you should secure the default directory containing these trace files 
(/QIBM/UserData/HostPublisher/log) against anyone viewing its contents except for the owner of 

file:///D|/readme.htm (5 of 24) [11/14/2003 12:28:44 PM]



IBM WebSphere Host Publisher, Version 4.0 README

the directory. If you change the location for trace and log files, you should similarly secure the 
new location. 

On Windows NT and Windows 2000, however, there is no ability to secure a directory from 
browsing. You will need to take any steps you deem appropriate to secure the Host Publisher trace 
file from observation. Because trace files are created only when the trace options are turned on 
from within Host Publisher Server Administration, or from within Host Publisher Studio by 
modifying the studio.ini file, you have control over when these files are created and what you do 
with them after they are created. 

You can prevent userlist passwords from appearing within trace files by specifying that they be 
encrypted during the transfer to server step within Host Publisher Studio. Refer to the 
Administrator's and User's Guide for more information on securing user information. 

Configuring Host Publisher to terminate orphaned connections

By default, Host Publisher relies on HttpSession invalidation to clean up connections that are no 
longer in use due to end-users prematurely closing their browsers. However, depending on the 
WebSphere Application Server configuration and the types of applications being processed, it is 
possible that HttpSession invalidation can occur on a different application server than where the 
Host Publisher connection is established. 

You can avoid this problem by making Host Publisher terminate connections rather than relying 
on WebSphere Application Server to do so. To do this, configure your Host Publisher connection 
pools such that their "maximum busy time" setting is less than or equal to the HttpSession 
invalidation timer setting in WebSphere Application Server. 

To configure maximum busy time for a connection pool in Host Access: 

1.  Click the Connection Pools tab. 
2.  Select the connection pool from the list, or create a new connection pool using File > New 

Connection Pool.... 
3.  In the Pool Configuration pane, click the Connection Pool Configuration tab. 
4.  Type a value in the Maximum busy time before disconnection field. 
5.  Save your changes. 

To configure maximum busy time for a connection pool in Database Access: 

1.  Click the Connection Pools tab. 
2.  Select Create a new connection pool and type the pool name, or select Share an existing 

connection pool and select a pool from the list. 
3.  Click Pool Properties. 
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4.  In the Connection Pooling Properties window, type a value in the Maximum busy time 
before disconnection field. 

5.  Click OK. 

Maximum busy time also applies to XML Gateway connections. To set maximum busy time for 
XML Gateway connections, edit install_dir\Server\hPubPortalData.xml (where install_dir is the 
directory where Host Publisher Server is installed) and update the <other> field for each of the 
sessions. For example, <other> maxbusytime=1800; </other> sets the maximum busy time to 
1800 seconds (30 minutes), which is the default HttpSession invalidation timer setting for 
WebSphere Application Server. 

Note that the default setting for maximum busy time is -1, which means that Host Publisher does 
not terminate connections. 

Errors when adding a node to a deployment manager

When adding a WebSphere Application Server base node to a deployment manager, you might 
see an out-of-memory error message in the log file. This message is logged when you include 
applications as you add a node. The out-of-memory message occurs in the following situations: 

❍     You issue an addnode command from a WebSphere Application Server base node on AIX 
or Solaris 

❍     You add a node from the deployment manager administration console on AIX or Solaris 

The problem occurs because the maximum JVM heap size is not large enough. The maximum 
JVM heap size should be 512 MB. There are two methods of increasing the heap size: 

At the WebSphere Application Server base node on AIX or Solaris: 
Edit the addNode.sh script to add two lines. Locate the line with -Xbootclasspath. 
Add the following two lines: 

-Xms 128MB
-Xmx 512MB

Run the addNode command again. 

In the deployment manager administration console on AIX or Solaris: 
Click System Administration -> Deployment Manager -> Process Definition -> 
Maximum Heap Size. 

After you change and save the heap size, stop and restart the server before attempting to 
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add the node. 

Changing node states after Host Publisher installation

If you change the node state from federated to standalone after installing Host Publisher, you must 
re-establish the configuration of Host Publisher. See the Planning and Installation Guide for 
information about the following commands: 

❍     HPconfig5 for AIX, Solaris, and Windows 
❍     cfghpsvr for iSeries. 

Additional functions and capabilities

JDBC/ODBC Bridge not officially supported

The JDBC/ODBC Bridge for gaining JDBC access to a database with an ODBC interface is a 
productivity aid provided by Sun Microsystems, Inc. Sun does not officially support this tool, and 
consequently neither can IBM. If you decide to use the JDBC/ODBC Bridge with an ODBC-
enabled database, be aware that there are limitations and problems with the tool. They are 
described in the Troubleshooting chapter of the Administrator's and User's Guide. 

For more information about the JDBC/ODBC Bridge, visit the JDBC Frequently Asked Questions 
page (hosted by Sun Microsystems, Inc.). 

Supported locales for AIX and Solaris

Host Publisher Server supports the following double-byte locales. 

For AIX: 

Japanese (PC) Ja_JP (IBM-943)

Korean (EUC) ko_KR

Simplified Chinese (GBK) Zh_CN

Traditional Chinese (BIG5) Zh_TW

For Solaris: 

Japanese (EUC) ja (JIS x0201-1976)
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Korean (EUC) ko

Simplified Chinese (EUC) zh_CN

Traditional Chinese (BIG5) zh_TW.BIG5

Support for bidirectional languages

The document hpbidi.html (located in the install_dir/SDK/Bidi directory) contains instructions for 
developers who are preparing Host Publisher applications that include Hebrew and Arabic data. It 
also provides the information necessary to add the bidirectional tags and directives to the 
JavaServer Pages (JSPs) generated by Host Publisher Studio. 

The JavaBean bidibean.jar file (located in the install_dir/SDK/Bidi directory) in some cases is the 
only way to have correct bidirectional text when this text must be passed from an HTML form, 
which is implicit, to the host as visual text. 

Support for Windows 2000 Professional

For your use in developing applications, Host Publisher Server can be run in a Windows 2000 
Professional environment. 

Changes to Host Publisher Studio

Application Integrator changes

The following are changes that have been made to the Application Integrator component of Host 
Publisher Studio. 

Support for Remote Integration Objects (RIO) removed

In earlier versions of Host Publisher, you could develop Remote Integration Objects (RIOs) to 
access Integration Object data from a Java program (applet or application) running on a remote 
machine. With the current version, you can only use Web Services to perform this function. 
Support for RIOs no longer exists in Host Publisher. When Application Integrator creates an .ear 
file for the application, you no longer have the option of including RIO support in the application 
archive. 

Refer to the Administrator's and User's Guide for information on the advantages of using Web 
Services. 
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Dependent files not included by default

In earlier versions of Host Publisher, the Application Integrator generated .ear files containing 
xerces.jar and xalan.jar files by default. These .jar files were added to support the z/OS operating 
system, which is not supported by Host Publisher Version 4.0.1. 

Now, applications generated in the Application Integrator do not include these .jar files, unless 
you specify that they should be included. To include them, edit the studio.ini file and set 
INCLUDE_DEPENDENT_JARS=true. 

Host Access application changes

The following are changes that have been made to the Host Access application. 

Support for Remote Integration Objects (RIO) removed

In earlier versions of Host Publisher, you could develop Remote Integration Objects (RIOs) to 
access Host Access Integration Object data from a Java program (applet or application) running 
on a remote machine. Support for RIOs no longer exists. When you create an Integration Object 
in Host Access, you can no longer generate RIO support files nor modify properties for RIO. With 
the current version, you can only create Web Services. Web Services can perform the same 
functions while running in the WebSphere Application Server container. 

Refer to the Administrator's and User's Guide for information on the advantages of using Web 
Services. 

Modifying screens in macros

In earlier verions of Host Publisher, if you wanted to modify screens for a macro after they were 
created, the process was difficult. Now if you select to modify a screen, and its description 
matches the current screen in the terminal pane, you can use the Screen Recognition Wizard to 
add or edit screen recognition criteria. You can mark text instead of typing it into an input field. 
You can also select the text position, the cursor position, and the number of fields on the screen 
without having to enter the numeric values into input fields. 

Deletion of multiple nodes in the navigation tree

In earlier verions of Host Publisher, you could mark several nodes in the navigation tree, but 
when you selected to delete the nodes only the first node marked was deleted. Now, when 
multiple nodes are marked and you select to delete the nodes, all of the marked nodes are deleted 
from the tree. 
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Additional preference saved when recording a macro

In earlier verions of Host Publisher, each time you extracted information from a screen, you had 
to select whether the information was a table or plain text. Now, Host Access saves the last type 
of text used for extraction. The next time you extract information from a screen, the last type of 
text used is selected by default. 

Database Access application changes

The following are changes that have been made to the Database Access application. 

Support for Remote Integration Objects (RIO) removed

In earlier versions of Host Publisher, you could develop Remote Integration Objects (RIOs) to 
access Database Access Integration Object data from a Java program (applet or application) 
running on a remote machine. Support for RIOs no longer exists. When you create an Integration 
Object in Database Access, you can no longer generate RIO support files nor modify properties 
for RIO. With the current version, you can only create Web Services. Web Services can perform 
the same functions while running in the WebSphere Application Server container. 

Refer to the Administrator's and User's Guide for information on the advantages of using Web 
Services. 

Corrections to publications

Section of Programmer's Guide and Reference no longer 
applicable

There is a section titled "Defining Host Publisher Server as a WebSphere custom service" in the 
Programmer's Guide and Reference. This section is not valid with Host Publisher Version 4.0.1 
and should be ignored. 

Host Publisher can be defined as a custom service; however, the EJB-based distributed 
administration of Host Publisher Version 4.0.1 prevents the Host Publisher Server runtime from 
being started as it was with previous releases. 

Suggested value for com.ibm.SOAP.requestTimeout incorrect in 
Planning and Installation Guide
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In the Planning and Installation Guide for the different operating system platforms, there are 
sections that contain directions to update the value of the com.ibm.SOAP.requestTimeout to 1800. 
The section headings in the Planning and Installation Guide are as follows: 

IBM AIX, Sun Solaris, and Microsoft Windows 
Before installing Host Publisher Server 

iSeries 
Prepare to install Host Publisher Server 

Host Publisher uses the SOAP connection for configuration. The com.ibm.SOAP.requestTimeout 
value specifies how long Host Publisher waits for a response to a SOAP request. If the SOAP 
request times out, you receive an exception error. 

Some installations might still get the exception even when the com.ibm.SOAP.requestTimeout 
value is set to 1800. We recommend that you set the value for the com.ibm.SOAP.requestTimeout 
to 3600 instead of 1800. 

Additional .jar file required for IOs in an IDE

If you are using Host Publisher 4.0.1 Integration Objects in an integrated development 
environment, the IDE will need access to the HPAdminEJB.jar file. This file is not listed in the 
"Preparing to work with an Integration Object" section of the Programmer's Guide and Reference. 
The HPAdminEJB.jar file exists in the following locations: 

On a standalone node: 
wasInstallDir\installedApps\nodeName\HPAdminEar_myhost.ear\HPAdminEJB.jar 

On a federated node: 
wasInstallDir\installedApps\cellName\HPAdminEar_myhost.ear\HPAdminEJB.jar 

where wasInstallDir is where WebSphere Application Server is installed, nodeName is the name 
of a standalone node, cellName is the name of a cell in a federated environment, and myhost is the 
hostname of your server. 

Additional Database Access properties in Web Services

When you creating a Web Service from Host Publisher Integration Objects, you must set some 
input properties to 0. Database Access has two additional properties that must be set: errorCode 
and HPubWarningOccurred. These properties are not listed in the "Creating Web Services from 
an Integration Object" section of the Programmer's Guide and Reference. 
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Messages Reference

Following are updates for the Messages Reference. 

The correct text, explanation, and user action for message HPS5025 are as follows: 
HPS5025 Missing mandatory attribute {0} in object {1}. 

Explanation 
An error was found creating the named object. The mandatory named attribute is missing. 

User Action 
Examine the pool and connection XML files, and ensure you are providing the mandatory 
attribute for the named object. 

Disregard message HPS5026. 

Add message HPS5141, which can be issued when attempting to administer the Host Publisher 
Server instance with an invalid port number. 
HPS5141 The port {0} specified by the HPAdminPortNumber property in server.properties 
file is invalid or not active. Administration of the Host Publisher Server instance(s) on this 
host will not be possible. 

Explanation 
An error was encountered in attempting to use the port specified by the 
HPAdminPortNumber property in the server.properties file. Until this is remedied, the 
Host Publisher Administration console cannot be used to administer this instance of Host 
Publisher Server. 

User Action 
Change the value in server.properties to the correct port number value. For a standalone 
WebSphere Application Server, this value corresponds to the BOOTSTRAP_ADDRESS 
end point of the Host Publisher Server Application Server. For a WebSphere Application 
Server that is part of a Network Deployment, this value corresponds to the 
BOOTSTRAP_ADDRESS end point of the Node Agent Server for the node where Host 
Publisher Server is installed. You can use the WebSphere Application Server 
Administrative Console to display the BOOTSTRAP_ADDRESS end point values. 

Add the following messages, which can be issued when the Host Publisher Problem 
Determination Bundling Tool service utility is run. 
HPS5746E Unable to copy {0} 

Explanation 
The named file or directory cannot be copied. 

User Action 
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If WebSphere Application Server has been uninstalled, the file or directory may no longer 
exist. Environment variables may be set incorrectly. Check that the file 
server\common\service\lib\hpserverevn.bat or the equivalent .sh file 
exists and has appropriate values. 

HPS5747E Unable to copy application configuration files. 
Explanation 

This message appears with message HPS5604 Directory {0} is missing. An application 
directory WebSphere Application Server configuration list contains no files. 

User Action 
None. 

HPS5748E Security Exception {0} 
Explanation 

A security exception occurred while trying to create a directory. 
User Action 

Ensure you are authorized to create directories on this server. Check WebSphere 
Application Server security settings. 

HPS5749E Duplicate or invalid argument: {0} 
Explanation 

The Java program that copies selected WebSphere Application Server configuration files 
(GetWASCfg) received an invalid or duplicate argument. 

User Action 
Ensure that the hppdtool (hppdtool.bat, hppdtool.sh, or hppd400.sh) has not been 
corrupted. Environment variables may be set incorrectly. Check that the file 
server\common\service\lib\hpserverevn.bat or its equivalent .sh file 
exists and has appropriate values. 

HPS5750E Arguments are {0} 
Explanation 

This message appears with message HPS5749E Duplicate or invalid argument: {0} and 
lists the arguments that were received. 

User Action 
Contact IBM service and provide the argument information. 

HPS5751E Missing Argument {0} 
Explanation 

The Java program that copies selected WebSphere Application Server configuration files 
(GetWASCfg) did not receive all the required arguments. 

User Action 
Make sure that the hppdtool (hppdtool.bat, hppdtool.sh, or hppd400.sh) has not been 
corrupted. Environment variables may be set incorrectly. Check that the file 
server\common\service\lib\hpserverevn.bat or its equivalent .sh file 
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exists and has appropriate values. 

Add the following messages, which can be issued during application migration. 
HPS5816E {0} contains EJB1.0 support code and cannot be migrated. It must be rebuilt 
with EJB1.1 support code. 

Explanation 
The named application was built with EJB1.0 support code. WebSphere Application 
Server 5 does not include support for this EJB level. The application cannot be migrated. 

User Action 
The application must be re-created with EJB1.1 support code. If you have the source for 
the application, import it into the Host Publisher 4.0.1 Studio. Open the Integration Objects 
in Host Access, ensure that the Create EJB1.1 integration Object Support option is 
selected, and save the Integration Objects. Re-assemble your application with the 
Application Integrator. Transfer the application to WebSphere Application Server 5 and 
install it. 

HPS5817E Application {0} cannot be migrated as it requires RIO which is not available in 
the WebSphere V5 environment. 
Explanation 

The named application cannot be migrated. Remote Integration Objects (RIO) are not 
supported in Websphere Application Server 5. This application has no JSPs (other than a 
possible error page) and no servlets (other than the RIO servlet). This application will 
provide no function in WebSphere Application Server 5. 

User Action 
Replace the application with one that uses Web Services. 

Add message HPS5832, which can be issued during application migration on both the Server and 
the Studio. 
HPS5832 The current path {0} has been modified to {1} at line {2} of file {3}. 

Explanation 
The path referenced in the specified file was modified during migration. 

User Action 
Verify that the new reference is correct. 

Limitations

Host Publisher Server Administration limitations

The following are known limitations or problems with the Host Publisher Server Administration 
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application. 

Unknown host error when using Host Publisher Server Administration to start XML 
Gateway

If you try to start an XML Gateway session using the XML Gateway Administration panels in 
Host Publisher Server Administration, and you receive an error message stating that the host name 
is unknown, it might be because you are not using a fully qualified host name. 

For example, if your host name is host1 and your domain is domain.com, and the error message 
says "host1 is unknown", try either of the following solutions. 

❍     Change your browser to bypass proxy servers for local addresses. The XML Gateway 
session starts, using the URL http:\\host1..., and bypasses the proxy server.

❍     In Host Publisher Server Administration, click Select Host and Application Server, and 
enter the fully-qualified host name in the Enter a new host to administer field. The XML 
Gateway session starts, using the URL http:\\host1.domain.com..., and uses the proxy 
server without generating an error message. 

Netscape 4 users must manually change character set to UTF-8

Because Host Publisher Server Administration displays data in UTF-8 format, the character 
set/encoding value for the Web browser must be set to UTF-8. 

In Microsoft Internet Explorer and Netscape 6.x, the encoding value is changed automatically 
from its current setting to UTF-8. However, this is not done for Netscape 4.x browsers. 

In order for data to display correctly in a Netscape 4.x browser, the user must click View > 
Character Set and manually change the setting to UTF-8. Refreshing the screen at this point will 
result in the correct characters being displayed. 

Limitations in switching to double-byte languages on Windows operating systems

If you use Select Language to change the presentation language in Host Publisher Server 
Administration, you might see corrupted characters when switching to a double-byte language or 
when switching between double-byte languages (Simplified Chinese, Traditional Chinese, 
Korean, or Japanese). 

To correct this problem, click Regional Options in the Windows Control Panel, change the locale 
and the default system language to the language you just selected in the Server Administration 
page, and reboot the operating system. 
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Netscape on AIX has limited support for Turkish locales

Because Netscape on AIX has limited support for Turkish locales, we recommend that you use a 
Windows browser to remotely administer your AIX Host Publisher Server in Turkish. For a list of 
limitations and instructions on how to work around them, refer to the Host Publisher Technical 
Notes database, and search for Technical Note 20675. 

Change fonts to display Host Publisher Administration in Simplified Chinese on 
AIX

In AIX, in order to properly view Host Publisher Administration in Simplified Chinese using a 
Netscape browser, it is necessary for you to make the following changes: 

1.  Change the LANG environment variable: export LANG=ZH_CN 
2.  In the browser window, click View > Character Set and select Unicode (UTF-8). 
3.  In the browser window, click Edit > Preferences > Fonts and change the settings as 

follows: 
■     For the Encoding: Unicode (UTF-8) 
■     Variable Width Font: (Monotype, ucs2.cjk, china-0) 

Application Integrator limitations

The following are known limitations or problems with the Application Integrator component of 
Host Publisher Studio. 

Transferring to servers with multiple network adapters

Application Integrator uses FTP to transfer applications created in Host Publisher Studio to Host 
Publisher Servers. If your Host Publisher Studio machine has multiple network adapters you 
might receive a FtpProtocolException: PORT error during the transfer step. If you receive this 
error, change your adapter order on the Network Binding so that the primary adapter is the first 
adapter in the protocol list. 

Mnemonics may not work

Mnemonics on menu items may not work in Application Integrator if a menu item is not 
highlighted. In this case, you can use the Tab and arrow keys to traverse through menu items. 
Press the Spacebar to run the selected item. 
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Host Access application limitations

The following are known limitations or problems with the Host Access application. 

Removing Integration Objects

Currently, there is no way to automatically remove all of the parts that make up an Integration 
Object. If you want to clean out unused Integration Objects or session definitions, here are some 
considerations: 

❍     The Integration Object files are all given the same prefix name and reside in the 
/Studio/IntegrationObjects and /Studio/SessionDefs directories.

❍     Before removing connection definition files from the /Studio/SessionDefs directory, make 
sure that other Integration Objects are not also using these same definitions.

❍     Enterprise JavaBeans (EJB) Access Bean files reside in the directory 
install_dir/Studio/IntegrationObjects/EJB/IO_Name/IntegrationObject (where install_dir 
is the directory where Host Publisher is installed and IO_Name is the name you gave to the 
Integration Object). 

❍     Web Services support files reside in the directory /Studio/IntegrationObjects/ws/IO_name 
(where IO_name is the name of the Integration Object). 

Avoid using the & character in screen names

Avoid using the ampersand (&) character when you define screen names. Some parsers resolve 
the & character as a null. As a result, when you play a data macro that contains such a screen 
name, the data macro fails because it cannot find the desired screen. 

Considerations for working with chained Integration Objects created with previous 
versions of Host Publisher

Some versions of WebSphere Application Server have a limitation on the size of the name used to 
bind an object into an HttpSession. Host Publisher binds a small object into HttpSessions in order 
to implement Integration Object chaining. Because of this size limitation, state labels specified on 
the Host Access Configure Object Chaining selection are limited to 12 characters in length. 

Host Access enforces this length limitation for newly created Integration Objects. However, you 
may have to adjust the state labels for chained Integration Objects created using previous versions 
of Host Publisher. 

If you try to import a label from an Integration Object created with a start or stop state label 
longer than 12 characters, an error message is displayed. You will not be able to import the label 

file:///D|/readme.htm (18 of 24) [11/14/2003 12:28:44 PM]



IBM WebSphere Host Publisher, Version 4.0 README

until you have made it 12 characters or less. 

To edit the existing Integration Object, open the Integration Object in Host Access and click 
Options > Configure Object Chaining. If its state label is longer than 12 characters, the state label 
field displays as blanks. Enter a new state label and save the Integration Object. 

Sample application for Host Access Web Services

When you generate a sample application in WebSphere Studio Application Developer (WSAD) to 
test a Web Service you have developed using the Host Access application in Host Publisher 
Studio, consider the following: 

1.  We recommend that you use Version 5 mapping because of how indexed data is handled. 
You set Version 5 mapping by deselecting Use V4 Mapping in the Web Services 
preferences of WSAD. 

2.  When creating a Web Service using Version 5 mapping, the code created in the Web 
Service client program might cause compile errors. Creating a Web Service might create 
Java classes with the same name as existing standard Java classes (for example, 
java.lang.Exception or java.lang.Enumeration). If you create a Web Service for an 
application that is dependent on the standard Java class, a name conflict with a created 
Java class causes compile errors. 

To avoid the compile errors, delete the duplicate class. 

English key displays when editing keyboard settings

You can use Edit Keyboard Settings in Host Publisher Studio to assign keys or key combinations 
as shortcuts to functions. When you press a key, it is mapped correctly for your language, but the 
key that displays is the English keyboard equivalent. 

Mnemonics may not work

Mnemonics on menu items may not work in Host Access if a menu item is not highlighted. In this 
case, you can use the Tab and arrow keys to traverse through menu items. Press the Spacebar to 
run the selected item. 

Mnemonics do not work when the terminal pane has focus

Keyboard mnemonics (for example, Ctrl+b to move back) do not work when the terminal pane 
has focus and is enabled for keyboard input. When the terminal pane has a yellow border, 
keyboard input goes to the host. To use mnemonics, you must first move the focus off the 
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terminal by pressing Ctrl+Tab or Ctrl+Shift+Tab. 

Loss of focus using Studio with Windows 98

If you are using the Host Access application on Windows 98, the focus might be lost in the Host 
Configuration pane when you want to type a new pool name in the text field labeled Create a 
new pool. If this happens, click File > New, then click Next to return to the Host Configuration 
pane. You are then able to type continuously in this field. 

Database Access application limitations

The following are known limitations or problems with the Database Access application. 

Removing Integration Objects

Currently, there is no way to automatically remove all of the parts that make up an Integration 
Object. If you want to clean out unused Integration Objects or session definitions, here are some 
considerations: 

❍     The Integration Object files are all given the same prefix name and reside in the 
/Studio/IntegrationObjects and /Studio/SessionDefs directories.

❍     Before removing connection definition files from the /Studio/SessionDefs directory, make 
sure that other Integration Objects are not also using these same definitions.

❍     Enterprise JavaBeans (EJB) Access Bean files reside in the directory 
install_dir/Studio/IntegrationObjects/EJB/IO_Name/IntegrationObject (where install_dir 
is the directory where Host Publisher is installed and IO_Name is the name you gave to the 
Integration Object). 

❍     Web Services support files reside in the directory /Studio/IntegrationObjects/ws/IO_name 
(where IO_name is the name of the Integration Object). 

Mnemonics not implemented for menu items

The Database Access application is a Java AWT application. AWT does not support the use of 
keyboard mnemonics for accessing menu items using reserved keys on the keyboard. 

Sample application for Database Access Web Services

When you generate a sample application in WebSphere Studio Application Developer (WSAD) to 
test a Web Service you have developed using the Database Access application in Host Publisher 
Studio, consider the following: 
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1.  We recommend that you use Version 5 mapping because of how indexed data is handled. 
You set Version 5 mapping by deselecting Use V4 Mapping in the Web Services 
preferences of WSAD. 

2.  When creating a Web Service using Version 5 mapping, the code created in the Web 
Service client program might cause compile errors. Creating a Web Service might create 
Java classes with the same name as existing standard Java classes (for example, 
java.lang.Exception or java.lang.Enumeration). If you create a Web Service for an 
application that is dependent on the standard Java class, a name conflict with a created 
Java class causes compile errors. 

To avoid the compile errors, delete the duplicate class. 

XML Gateway limitations

The following are known limitations or problems with the XML Gateway emulator function. 

Browser-related recommendations

The following recommendations are related to your use of a Web browser for the XML Gateway. 

❍     When you use the XML Gateway, we strongly recommend that you use one of the 
following versions of Web browser: 

■     Netscape Communicator 4.7 or above
■     Microsoft Internet Explorer 5.0.2919 or above

❍     If you wish to use more than one XML Gateway session simultaneously, we recommend 
that you use a separate browser window for each session. 

❍     Using more than one XML Gateway session simultaneously is not possible with Netscape. 
This is because the Netscape browser window reports the same HTTP session ID for each 
window opened. A newly opened browser window would take precedence over previously 
opened browser windows. 

❍     We recommend that the browser window be dedicated to the XML Gateway session. If 
you open an XML Gateway session and then use the browser window for other work, it is 
possible that the XML Gateway session will be interrupted.

❍     When using the XML Gateway for terminal emulation in Microsoft Internet Explorer 
Version 5.0, do not open new browser windows using 
File > New > Windows. This causes multiple copies of the emulation session to be split 
between existing and new browser windows and results in inaccurate terminal-emulation 
screens.

❍     If you want to use the XML Gateway for 3270 or 5250 connections that use an Arabic or 
Hebrew code page, you must use a bidirectional capable browser such as Netscape 6.1 
(and above) or Internet Explorer 5.5 (and above). 
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Misaligned rows in XML Gateway

When you are using the XML Gateway emulator and the Netscape browser, rows might be 
misaligned because of variable space fonts. 

To solve this problem, in Netscape, click Edit > Preferences. In the Category box, expand 
Appearance and then select Fonts. In the Fixed Width Font list, select a new fixed font. 

For example, select MS <Gothic> for Japanese, where MS is in English and <Gothic> is in 
Japanese. 

General problems

The following are other known limitations or problems with the XML Gateway emulator 
function. 

❍     Input fields in the terminal emulation feature of the XML Gateway default to insert mode. 
Because of this, cursor input is inhibited when these fields are filled with characters. (Bear 
in mind that "space" is a valid character.) In this case it is necessary to press the Insert key 
to toggle the field to "overwrite" mode. 

❍     With some Web browsers, it is possible that text cut or copied from the XML Gateway 
window and pasted into a text file will be misaligned.

Other limitations

Error message when opening PDF files in a language locale other than English on 
AIX or Solaris

Acrobat Reader (a product of Adobe Systems Inc.) is offered only in English on UNIX-based 
operating systems such as AIX and Solaris. 

As a result, you might experience problems when attempting to open a PDF file in a language 
locale other than English on these platforms. (The Host Publisher documentation is stored in PDF 
files, as well as in HTML files.) Errors typically displayed suggest font access or extraction 
problems with the PDF, but the errors actually occur because the English Acrobat Reader cannot 
function correctly in an AIX/UNIX language locale other than English. 

To view PDF files with Acrobat Reader without error, you must switch to the English locale 
before launching the English Acrobat Reader. To switch to the English locale, do one of the 
following: 
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❍     Add the following after #!/bin/sh in acroread, the launch script file: 
LC_ALL=C;export LC_ALL 
Note: Editing the launch script in this way ensures that other applications, such as 
Netscape Navigator or an application Help menu, can launch Acrobat Reader without 
error. 

❍     Enter LC_ALL=C before attempting to open Acrobat Reader to view PDFs of any 
language. 

General appearance problems

The following limitation is associated with general Java appearance or JavaHelp: 

❍     You cannot multi-select files in the Open File dialog. 

Some double-byte characters not recognized as valid in Netscape

If you enter double-byte characters in fields on the Set Log Options and Set Trace Options 
windows, you might get incorrect results. For example, some log and trace file names might not 
be accepted as valid. This problem occurs only with some Netscape browsers, particularly with 
Netscape 4.76. 

If you encounter this problem, obtain a version of Netscape for your particular language or 
upgrade to Netscape 6.1. 

Unable to view Host Publisher documentation in HTML format using a Netscape 
browser on a Turkish AIX system

The JDK that shipped with Netscape on AIX is missing the font for viewing Turkish characters. 
To resolve this, copy the font file (instmgr/aix/jre/lib/font.properties.tr on the Host Publisher 
installation CD) into the /usr/netscape/communicator/java/classes directory. Note that this font file 
is appropriate only for the Turkish ISO 8859_9 tr_TR locale. 

No message for unavailable device in Windows 98

In Windows 98, if you select a device that is unavailable -- for example, drive A: with no diskette 
in it -- no error message is issued. Be sure the devices you select are ready before you try to 
access them. 

Help keyboard mnemonic (Alt+Shift+?) for Italian version

In the Italian language version of Host Publisher, the keyboard mnemonic for help (Alt+Shift+?) 

file:///D|/readme.htm (23 of 24) [11/14/2003 12:28:44 PM]



IBM WebSphere Host Publisher, Version 4.0 README

might not work. Use the mouse (point and click) to access any menu item that has ? as its 
mnemonic, or use Alt+? in place of Alt+Shift+?. 

Change fonts to display Readme in Simplified Chinese on AIX

In AIX, in order to properly view this Readme file in Simplified Chinese using a Netscape 
browser, it might be necessary for you to change the font settings for your browser. 

Click Edit > Preferences > Fonts and change the settings as follows: 

❍     For the Encoding: Unicode (UTF-8) 
❍     Variable Width Font: Interface System (Dt, ucs2.cjk, china-0) 

Corrupted characters in title bar when viewing publications in Simplified Chinese 
on AIX

In AIX, when you view Host Publisher publications in Simplified Chinese using a Netscape 
browser (using the Zh_CN locale), you might see corrupted Chinese characters in the title bar. 
The contents of the publications, however, will be displayed correctly. 

Trademarks

AIX, DB2, IBM, iSeries, OS/400, WebSphere, and z/OS are trademarks or registered trademarks 
of the IBM Corporation in the United States, other countries, or both. 

Microsoft, Windows, Windows NT, and the Windows logo are trademarks or registered 
trademarks of Microsoft Corporation in the United States, other countries, or both. 

Java, all Java-based trademarks and logos, JDBC, and Solaris are trademarks of Sun 
Microsystems, Inc. in the United States, other countries, or both. 

UNIX is a registered trademark in the United States and other countries licensed exclusively 
through The Open Group. 
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